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ABSTRACT

Current advancement of technology leads the innovation of embedded systems that are applicable to

rescue robot arena. The rescue robot can reduce human risk that may occur to a rescue team.

This development project is the application of an object-oriented systems development
approach into the embedded systems. The aim of this project is to implement the rescue robot that
composes of a motion control system, camera rotation control system and bluetooth signal
strength and robot power monitoring system. The project includes the hardware design of robot
structure by using the Lego Mindstroms NXT installing LeJOS firmware. The Java IDE is also
employed to implement the software of robot control systems. This development project can be

deployed as the approach to develop the rescue robot in practice in the future.
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/15minuteswithNXT.tml)

710 2.10 nuamewiinnisow leeou Indwes (ttp:/www.nxtprograms.com
el 9797 html



Power Bluetooth* usB
supply Bluecore™ 4.0
Display SPI-Bus UART-Bus Sound
Main Processor
Atmel” ARM7
e “iffeiye
E -
£ Buttons u 2C-Bus 3
.
- e
g a
3 =
cay Co-Processor fra—,
Atmel” AVR

1 @ o 1 ° v 4
51 211 anuduiusvssdumshnudg yodeudndinou Insames

http://mi .blogs

232 1BUIBNFNNBINGS (NXT Motor)
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gijﬁ 2.16 Lego MINDSTORMS Robotics Invention System (RIS) (Pavel Krcal.
2005. http://www.it.uu.se/edu/course/homepage/realtid/h05/ass2)
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Biuetooth Controller
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(BlueCove Team. 2009. http://snapshot.bluecove.org/)
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5995 UM Uou T1)51n5uFIAG(Object-Oriented Programming)
AWTONNUTINNY IDE(Integrated Development Environment) DU1LHY
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1A ineaaTon Juleudd

FOITUMINNIUAVUYNBUASIZTNIN NXT Ay NXT n?aqﬂnsﬁéuqﬁ
59451 SPP(Serial Port Profile)
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333 ganalaezunsu (Use Case diagram)
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3.34 ﬁ1a§anmnﬁ(Use Case Description)

319 3.5 Mefuoymaanisadiumsiyouds

Use Case Name: @3 19M1351¥0uAD ID: 1 Importance Level: High

Primary Actor: é’mur}u Use Case Type: Function

. o Lo : ' ' A 1 (4
Bricf Description: @3 19M5t¥eua 13 101uuugys5enanTeenIunuuasueua

Pre-Condition: Yuvud lannssuTisunsuiSoudeondn

Post-Condition: M3i¥ouAvIa3vauYy5al

. k4 ¥ Y A ¥
Trigger: AAIUANNAT|UAT1INTIFOUAD

Relationships:

Association: é’muqu

Normal Flow of Events:
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i R - & ' oy ° Y A y
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§ 3 a a A \J
ﬁ'lS'N;I 3.6 MOTUWYAAANITUNIANNTITIFOURD

Use Case Name: 0A1ann1515oune ID: 2 Importance Level: High

Primary Actor: é’ﬂ’mf]u Use Case Type: Function

. .. = 4 ' ' & ' ¢
Brief Description: umaﬂnﬁﬁauﬁa'ﬁ'muuuuuqmizwanmimmuqmmzuuﬂuﬂ

o A ' 1 ¥ '
Pre-Condition: M3t¥euse 1¥manuuugyssznhunissniuguuazvuous lagnadia1iuds

Post-Condition: N131¥0uABYNUNIAN

. v J a A '
Tngger: ﬂﬂjﬂﬂﬂﬂﬁﬂ“ﬂﬂlaﬂﬂ'ﬁﬂfﬂuﬁﬂ

Relationships:

Association: é’muqu
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M1319N 3.6 (AD)

Normal Flow of Events:
1. Hundesmumuhmsdeideendnnsdoude ddevuoud
2. Hajuosudiinmseni@nnsideune
3. Hunfesmunuimsaseiumsideuse emsideudegnonian Mmsudasaius
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M3 3.7 Mefueyananisduaziumids

Use Case Name: @9ilaz 5 UA 169 ID: 3 Importance Level: High

Primary Actor: ﬁuuuﬁ Use Case Type: Function

1 v o w 1 y y o
Brief Description: daitaziumdeszniedfniuguuazderuous

A ' ' 4
Pre-Condition: M31¥ouAe 13 menuuugysizuituns ssnsuguuasuoud idgnasia1iuda

Post-Condition: fi1aagnassinaumi lilialaienie

Trigger: AUNIABIMIasdoyalaoma

Relationships:

v [
Association: HYURA

Normal Flow of Events:
ay a_ A
NIUAUNIABIATBINIVAN
1. Huaseemuguinmsivideanndauquudnimsulacdeyaldeglugluuuiismua

2. HanTeamunguimsdsdoya lUdsilajuoud

3
o

3. Aejusudimsiudeyaudiihmsulasdeyalieglugduuumdsiidmua 1’
a Y = J 3
NIUAUNMIIABY HLIUA
Y 3 d o o 1 { o 1 o o A
1. HvjusuaimaimsulasdeyalveglugiuvundmuaBudrdsdoya lidilunies
AIUAY

2. Hajuouaiimsiudeyaudvimsmlasdeyalieglugluuumdsnsmun

Exceptional Conditions: ¥1n3z31emisdsdoyaiiadodanaia msi¥oudeszgnonian
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M3 3.8 Mo usyananlIuguMTAABUNveIUUA

A 4 ' 7 .
Use Case Name: muqumsmaauﬁumuuauﬂ ID:4 | Importance Level: High

Primary Actor: Pjﬂ’l‘l]f}ﬂ Use Case Type: Function

[ 4 ] o [ g o o
Brief Description: 1I1Jmﬁau'mlU‘unmmﬂumimm]umiﬂqu'uml.aumﬂmﬁuﬂmai

. 4 ' ' A '
Pre-Condition: M3i¥euse 1¥mouuuugyssznhuniesntuguuaziuous lagnaiialiuds

1 ¢ & 4 0w
Post-Condition: uuuumﬂaauﬁﬂﬂmumm

; y : i 4
Trigger: RAIUANNALUAIVAUMIIAABUN

Relationships:

— 9
Association: §AIUAN

Normal Flow of Events:
1. Huniesnruguinmsiumdwngaaungu
2. AunTeanuguinnisdedoyn lldadauoua

y 1 d o o 9 o & a o @ w 1
3. ﬂmuﬂuﬂ‘n1miiu'ﬁ'ﬂgaummmimaauwmummmnm’;

Exceptional Conditions:

3190 3.9 Mo uegmAanIUANNTINYUNABIIA 1B

Use Case Name: A9UANNT Hl‘luﬂaﬂﬁﬁ’iﬂ ID:5 | Importance Level: High

Primary Actor: Q’muqu Use Case Type: Function

Brief Description: i1 nADYIA 1B

Pre-Condition: M3t¥ouse |Fmaiuuugyssznhaniesnuguuajuouq lagnadiaBuds

Post-Condition: ¥)jUNABIIA 10ATINIWTIANI

) v ’ Yy aa
Trigger: §AUANNAIUAIVANNITHYUNABITIA D

Relationships:

Association: é’muqu

Normal Flow of Events:
1. Aunsesmuguihmsiumdsingaiugu
2. Wansesmuguimsdadeyalilddflejuoua

y ] d o [ o y 4 o & w '
3. Hajuouaiimsivdeyaudnhmanieunaumdininan
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13190 3.9 (9D)

Exceptional Conditions: NAp33@ Ieaunsavayu lunuaszun1dugae -180 s 180 o9 wag
wyuTunuaas1dlugaq 0 i 180 varn mindaduguiihnisvagu

wonmilevInBImaIna szuvee lillszuranaiids

A13197 3.10 MOTLWYAAAATIVABUNAINUUAZ TYYIUVYYS

Use Case Name: A329¢ auwﬁuwumﬁmmmuqm ID:6 Importance Level: High

i Actor: Use Case Type: Function
yp

o (% 1 (4 v W
Brief Description: ATIVADUITTAVNANNIUYBINUIUA HasATIIADUITAY iyiy'lm'llﬂﬂﬂ'liéﬂﬂ'ﬁ

1 4 1 o
Beneuuvugyssznhuniesmuguuasjusua

Pre-Condition: N151¥0use 13 100vUgYHsH AT 0IRRIAZUsUA lagnadialiud)

Post-Condition: 32 ULLAAITEAUNAINULIBS Ty IUUQY B

. A a2
Trigger: M3i¥ouABYNAS 19U

Relationships:

Association: g’{muqu

Normal Flow of Events:
1. Tunng 0.5 3ui HejusudzimsasisaeussaumasunasseRudyauugys
2. Hejuoudaiimsdeadeyaszaundsnuias szaudygnmugys hiddunTesniugy

3. HanTeeniugiinsianIHasZAUNG IR ST AU AR NN D

'
o @ =4

Exceptional Conditions: HnszAUTya1amdeLouatinding 203 szuvezisuna lntlesiu

v o
HUOUAINADUNDONUONTZILAILAN

H 14
M3197 3.11 MeTUIBYMATAIUANATUIBLARAN

Use Case Name: mnf,\mhmauaﬁn ID:7 Importance Level: High

Primary Actor: Q’n'mf}u Use Case Type: Function

4
o ' o 1 a
Brief Description: ATUAUNMITNINIUYDIYUUUARTUIDYTAN

. A ' 1 A '
Pre-Condition: M3t¥ouse 13mouuuugyssznhaniessnuguuazuoud lagnaie1iuds

0 [
Post-Condition: HUEUARII AT IAIATIYBII00AAN
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M13131 3.11 (71D)

4
Trigger: AAUAUNATJUAIUANAIIRIIUYDIIBLARN

Relationships:
Association: é’ﬂ‘mﬂu

Normal Flow of Events:
y & ° @ o w ' 2
1. HunSesmunguimssufmdenndgniuguiiuseuadn

v 4 ° [ o o [ 4
2. Huniesmuguihmsdadoya ldarauoua

3
W o 1

y 1 d o o g o 4 o °
3. ﬂwuuuﬂmmiwwyauﬁm1milﬂaaunmummmﬂan

Exceptional Conditions:

3.3.5 aaialneziniyl (Class Diagram)

comeentrainexusin,..

+PControl() -
+main(args)
+checkRe:

+getAxisA (nDir)

+joy stickAxisChanged(pJoy)
(+CreateConnectionNXT10 +updateNXT 1 (result) ;
+CloseConnectionNXT10 [+updateN«(T 2(result1)
+CreataConnectionNXT 20 ssavelogitext)

4 ' . o v d
310 3.7 uamsnanalaezunsuvesszuumuguusudasIumiedlszaunviuniesniugy

H ] A 4 ] [
131l 3.7 fie amaludiuveuniesnruguitannsamisesniunmandnld

v v
NIVUA 7 AR
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* AMAMUAMATENILAYN (PC control) iTunmamdniilFlumsnruqumsiinu
Havuavesszuuiuniesniuny

o AmansFouAs (Connection) 1unaraiildhinisideuse snidn nisdeas1iae
VLN BIENTNIATBIAILAULAZ MO

®  AmAAaATia (Send command PC) iHlunaraiilFdesasida ludsdejuoudlugiuuy

VDITHARITS 4 Man

» 3
@

®  aAmauURIdS (Receive command PC) iunaian1¥lumssunadnivessidendaan

y ' L v o w o v d
vinFauoua lugduuuvessiafide 4 nanaudionadng

]
[

o o { a J v
o amauaanadng i uilegiiu (Update resutt)y illunaai 19 lumsiinszvinadng
Y I '8 v o
TannHausuauazuanIHaaNS
®  AmanIURULY (Control button) LAZAMIIAIUANLAU(Control axis) ilunaiaflFlunis

AIVAVMITNINIUYBIIOUAAN

«<impoit>>
NXTcontrol
-int Update_interval
-Thread checkSend
-BT C onnection btc
-int robot |_BTConnection
Lint speed_now B
.Dmxsum dos ST TN o
-DatalnputStream dis 3 -
it quality_link
i M otorControl_10)
+NX Tcontrol() F wm«””‘fd)
R o) +Back ward(speed)
+waltF orConnedion() +TurnLett()
+checkComand() L TurnRight()
+AdjustLeft()
+AdjustRight()
+Stop()
+change Speed(speed)
MotorControl
+MotorControl_2()
+F orward(speed)
+B ack ward(speed)
+TurnLett()
+TurnRight().
+Adjustleft()
+AdjustRight()
+Stop()
+change Speed(speed)

{ ] a1 PN 1 d
71N 3.8 uarasnana laesinsuvesssuumugutouRsIemaediss aunvilauoud
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o A ] [ I ] o 3
nngili 3.8 A amaludiuvesjuoudanaunsomisesnidunaanan lénanua 6
i d
AR
] d v a o .‘,’
® amAMLANYULUA (NXT control) Huamandnilflunmsaiugumainuimua
y 1 d =2 A 3 Y A
VoI UUHIusUATINDINITEMIIFONABIINAAIATBIAUAY
v a3 , - o e d &
® aAmATuRIA (Receive command) uamailFlumsfunitamdannduniosniugy
Tugduuuvessviamid 4 nan
1 o o 4 1 w o ° o [ y g
® amadsi s (Send command ) uaaanlFdiwadnivesiiden 1d5unndunTos
munugluuuvessHafids 4 nanmudonadng
®  AATEAILANNBIABS 1 (Motor control 1) LAZAMAAIUAUABIABS 2 (Motor control 2) 1111
aaai 1Flunsniugumsiausemssguin uazgras
®  AMAMILAUAADIIA 1D (Camera control) Huamanani 19 lumsniugumsnisvau
Y aa J o A s o a
¥03INAB3IA o TagarugunisviuveINemes 2 Afsuamesamuuuivyuluuulf uaz

Jd Y 1 o
uamasmuanwwquimmaisum
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NAT Conwoler 1

N1 Controller 2

notN

Accept connection |

®

4 aad) A '
31 3.9 uamaneniIn laozunsuveamsasamsi¥ends 1Fmonuuugys
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PC

NXT Controller1

NXT Controller 2

;Checkmcmcﬁm )

Canrgction?

Null

Stop thread
send and receive
‘ Stop moving

H acy H =) A M
1 3.10 uansuean I Tnezunsuvesnisenidnnnsouns 1S meonuuugys

‘IlConnact]

TextArea
- UpdateResuit

Connect/disconnect com:
; PCcontrof
T

o

o
1. capturainputEvent()

.

o DE(NXT1)
. NxTeantrol
T

bte(NxT2)
: NXTcontrol
T

|

3. waitForConmection()

2: CreateConnectionNxT1()

i
I
1
1
]
i
! CreateConnectionNXT2() 4: connectior] result
| /CloseConnectionNXT () 3
i CloseConnectionNXT2() & waltForConnection)) _ :
i 8: cannection resut 1;_] 7: Controfier=1 E
i o Soomectmresst i
H [1p: {roctCamm 1]jnxtComm2==null] : H
| 11 updateN<T1() = ] !
2 display | &&updateNXT2() | i i
U. i i i |
| | 1 ] |
i | | | | |
i - 4
3N 3.11 wamsdiaou laezunsuvesmsaduazsnidnmsiyeude 13meuuuugys
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a - 3 1 o o o A ' [ A
1ngIN 3.9 waz 3.11 Wednruguyusuaiimsdimsyende lldunseniugy
A o '\ o W & ' v 1 04 a w4 3 o
wiesmuguazhimsdamidslunmsveilansiyouns lidsuoua luvazi@ernuneuens
= i: -] A 1 A Vo A 1 y A
finouInsameinsasussnegluaniuzsenisi¥ouds e lasunmsi¥eudsindanios
=1 ° ' 4 ] 4 T a o o 4 [ :
AUAUNITIINMIA YR IINMsIFoNdAD MinmsFeuanailywineginmsi¥ourod
A o A ' y 9 y A ° v o W o 9 —
Weiimsireuas laudidaniesnruqueziiinisdamdalumsdmuaniinuas
Frnm@nmlumsadrmdsnunazszdudyanu) IdueudnanaeuInsamesuday
[ n’: y 1 (4 o a ° 1 o o o 4
a1 nmiuszuudsjusuasziinmsisumsiauvesnsadinaz sudeya wisniudunies
aufuIziIMIuMsIuYeunsaiudeya
4 4 9 WY TN FIC AT
nnglf .10 uaz 3.11 Wedaruguyusuaiinsdenidanmsiyeuse ldunies
& o v o W & ' X P I ¢
AU nFeanugueziinsdemidelunsvetlanisigoune hildarsuoua iielavusua
v o w 4 -] ° 1 o ' > °
1a5umdsvetlamsi¥oudenaziinisvgamsaduwazSudeya aovintiueziinisngans
A P ] d [ Yy aA 9 W 1o/ o 1 Y a &K °
wasunveusuAnazliunaesid le linyunauuisgdsinmiiedage deeziinsams
A 1 9 4 1 9 o A & [~ ° & 1
wounsuazIIgANIUZ IDNIIFENAD WIBUANNHIATBINIUAUNIZIINITIANTIFOUAD
1 L 1 1 v A 1 A A J =
wuiu uamnwuNHaugud imnsallanisiweude 1adsenialannilym

] v [
MINUPYEFWRIIURAN IR sypuIzdinsamisFeudesaunesanisyoude 1a
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\ | W o Q'J \J q +4 ; \J d
33.7 laezunsuaiumsauazsumdasznnadaaivnuuazidauaua

Operator

PC

NXT Controller 1

NXT Controller 2

l Click command }

~ Send command

)

)

B

sy

10 Exception

' Recgwe command

10 Exception

@ecm comm m@)

' Check command '

semi resuft

| Play sound and save log ]

Display
‘Command OK"

H b4 J .
311 3.12 uamaneniin lnezunsuvesnsdwaziudidesznieilednauguy (Operator) 1oy

Havuoud (Robot)
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sd Send and recelve NIVII'IM’
- UpdateResul % 3 C ¢ 2 3  NXTeortrot
Operator H H H Comn_!]er182
| i !
) | !
| 1: captureinpuE vent() — !
2: cammand() !
3 )
4 Q
4"’[‘]— HRaCHR ) 5 processC )
€: resut
H - command result
i i
h
8: result
9. checkResult() <t
10; updateN < T1()
"o AB&I.D&‘IMXTZ()
' v
| 1
1 | !
] | ‘ 1]
| 1 | |
1 | 1 '
| | | | 1
: ! ! ! : !

v
o o

71l 3.13 uansdinou laezunsuvesgmaamsdaay fufids

= & 9 1 ¢ o Y o W o &
nngli 3.12 e 3.13 dledniupuyusumihmIdemdelag llduniesnunu
A o @ o 2 o @ o 4 o/ y ) A y
inFesmunueziimadasiamdalugiunusia 4 nan damsaen 3.1 Tldwejuoud el

Y 0

Wuoud 135 ufdsizimsaneseuniamayhsiamdeinandaldszumhanes 1shee
o [ ° P v o W o A o -] |

dauhldgananistinusuinnoadesdudidadug uaziliosumaiinunzdinams
o o o o . o o v & : v
wamnduldfaniosnrugulugiluunsve 4 nanaudaewadns aovintiulyUsunsuds

& ° Y — w & o k4
msmmuqmzmmsuﬂmnaawmmzuuwnffaqamsmnu'l’a
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33.8 laozunsuaIumInIdoaeumNe I HYBUAIABINAZIZAL

fyqaueImsaeas 13muuuuugys

PC NXT Contraller 1 NXT Controller 2
t ®
( comectes ) (  comectes )
y
battery vaita battery voitage
al St &s

>

Every 0,‘5 second

Every 07%'second

»=203

<203
Check risky bits X

37U 3.14 udasnoANIA 1ADZINTNYBINITATIVABUATNAINIUYOUIUAIABT AL TSAL

dygavesmsiens aouuuugys

| sd Chack battery and signal !mn]
% RS | PN | e - ) vl
Operater : 14 . ! Controller1&82
e 'ﬂ getsSighalStre
getvoltdgeMiiny

1
1
1
[l
1
1
1

2: command() <=

: [Signal<203]
:=Motor stop()

———t Q2

6: UpdateN < T1() ” 5 checkResutt)
| KT 3 &
hispiay S&updateN<T2()

4: comthand()

%

potaite

|
|
]
L wey 05 I '

317 3.15 uaasdinou laoziNs HYBINITATINADUANAINUVBUILAINDS LLAZATIVABLTZAL

dyauvesmsdems iawnuuugys

1ngUit 3.14 uag 3.15 isszuudauoud ldhnmsiseudedullaniosniuguiade
L3 y ' ° ! o @ : v @
auyssinds syuudauoursziinsdeszaundenuvesuameiuazszAudygIMugYs

@ o & [ a = = v o ' o = °
Tdsraunsosnrugulugiawnamneg 0.5 uii uazluvaz@erdunilausuasziinsiiau
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Ll -~ = o o 1 L g o ﬂ'
agluiyW Inua (Safe mode) ADIZUMINTINABUITTAUTYYIULYYS MINAITTAUTYYIUN
YO da 19 ' o 4 4 3 a do_ o
Harueuatiniesndt 203 szuusziimsngamsindeunveeudniney Insameianiy

e rnaddin T g i 4 ay d 2
uaziimsdemidunou Risky bits) TFunsesnrugu eliiniesnruguududoulids
d A o 9 & P W 1 n’: o o
wuniineu Insamesonduied linganisinfioun udrreviniueziinisanisiniu

[ va A Yy ° Y 1 < A oy
vousd InuaTassa Tuld e lvdaiuguannsahinmsnvguldquesudinaeunesnain

v
YUY

v A oA v ¢
3.3.9 ‘lﬂazllﬂ'juﬂ']un'lﬁﬂ']ﬂf]uﬂ‘lﬂﬂﬂﬂuﬂ‘“ﬂ@nuﬂuﬂ

NXT Controlier 1
L}

( ~ Check command o )
\__iotate fropt maotor

Command code ?

{1003 / 1004 / 1005 //1006 / 10087 1008 © [Change jpeed]
7001 / 700§ / 7003

slow / meditim / fast

®

4 aadl 4 4 -4 4
31N 3.16 uamsuenIn laszunsunmsnIuguMsindeuNve DG ineu Insames

AN 1



[1003 7 1004 / 1005 /{1006 / 1008 / 1009] 7001 /700 / 7003
slow /m / fast

‘1 ( Left Motor =stop)
Mm-aqto

mm-wm] [um-m
_Right Motor = setSpeed(Current speed)

1003/1004 7

o aad) AT o~ ¢
11.]“ 3.17 llﬂﬂﬂllﬂﬂ'ﬂ')ﬂ1ﬁﬂzlln1un'ﬁﬂ']'Uf]llﬂ"l'ilﬂﬂﬂu’n‘lﬂilﬂulﬂﬂ‘lfﬂﬂﬂuTﬂﬁﬂmﬂﬁ

e

m2

=h.

sd_Contral rabot movement |

_commandCode | [ Motor Wotor
4 “ENXTcortrol : MotorContre]_1:
NXT NXT ! i i
Controller 1 Contraller 2 | 1 |
1 | |
| I |
i | i
: | |
1: chgckComand() | |
{{] 2 *MotorControl_ | |
1 |
l |
1 I |
| | |
g: checkComand() ! !
4: “"MotbrControl >l5_j
i
|

{ o A '
31 3.18 uamadinau laezunsuvesnisdumaouuoua
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131l 3.16 B9 3.18 Weszuudejusud Idsuddndaniesnuguissuioondy
< 0 Vo ¥ w ' o W g da Jo d °
Aazhmsasnaeuimdsssnariiudidla TavewdndinouInsameiaan 1 wging

K Y < da do o ° o o

auguuBABIgThdMeuDnGineu Insameiaan 2 wwihmsmuguuemeigras lae
a ' 'ow a o [ 4 o X { d
fiemaveaueimes guiuazgrasszvyuludirasatudwiu waziiledhnmsmdouinaie
- v = o o o o &
Foufeoudrnziimsaounduwanisia ludlanTesnugu

msnyudneuazyvesusuaiiumsvyu Tasdaeusnugaguinaavesueud

- ] [ A’ ] '
Whuganyudazali 3.19 Sadumanyunldvuidesiga

U1 3.19 HARIANHALMITNYUYDIY UOUA



3.3.10 laezunsuaIumInIuguMINYUNARIIATD

NXT Controller 1

[increase 45 degree]
Command code = 1016

[Decrease 45 degree]
Command code = 1015

[Back to reference point]
Comm code = 1020

Check degree
”-*,?dhfrm

pgree > (180) ?

[current

S
vl

Twoo <(0)?

H b4 '
71/ 3.20 uamaneniiin lnezunsun1svyundesIa leveuoudndiinou Insamasaaf 1

45



T Controller 2

@ [Reerence
degres = 0

Check command o
rotate bottom motor

Increase / decrease degree or Rotate to reference point?

Check degree
after rotate

<(-180) ?

degree > (180) ?

current Rotate bottom
degree = 180 otor 45 ™

current Rotate bottom
=0 motor 45 degree
]

Rotate bottom motor
current e + (current /45

Send current
degree to PC

o aaal aa 4 da o A
z‘.‘“ 3.21 llﬁﬂﬂllﬂﬂ“jﬁ"lﬂﬂzuﬂiuﬂ“’ﬁuuﬂaﬂqjﬂiﬂ”QQIﬂulaﬂm“ﬂﬂuT"ﬂﬁalaﬂiﬂ’)ﬂ 2

sd Ratate video camora)

R

NXT NXT
Comrgller 1 Controller 2

5|

b
______...42

1

1

|

: **CameraControlt =
| [Top_jncrease
| |Top_Decrease()

| )

|

2: *CameraControl1

“*CameraC ontiol2 =
! Bottom_Increase()

|
|
!
3: checkComand { Bottom_Decrease()
4: *CameraControl2 | '
|
|
1
|
|
1

310 3.22 uaasdinou laezunsuvesmsnyundesinle
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= 4 Y v o W y & =
1310 3.20 fla 3.22 Weszuuiaueun lATuMdInluniesnuguissuioonds

fezimsaseaeuimdedenariiludidala mindudideidesniinyundeslunun

M ' @ 3 da o A 4 o 1 ,
*UIY m’dwzqnm'lﬂmmulanmnﬂauTmamaim'ﬂ 2 maﬂuuuamaimma llﬁﬂ'lﬂl'ﬂu

o w Ay a o w 1 [ g3 da o o &
frdandeansnyundelunuias MdwzgndalldueuwdndiineuInsamesdin 1 e

o 4 o o ° [ A a
vyuueamesAIUY uaziiliemimsnyundeuadsSouiesudrnziimsdesesruouaasiin

nenmsiuvesndesllduniesniuguy

o é 1
33.11 'lﬂazunsmhum5m?sﬂm"lmsmﬁmam'umssuu

10 synchronized(this)

8. Command()
B 9: UpdathXT2()

capturelnputEvent()

12: capturelnputEvant()

1

RN

sd PC Thread
nxtComm‘ nxtCorm2 main _Joys command
: Connection | | : Connection | | Thre...| | Thread . SendCommandPC
! ! . feonected] | ! i | !
| 1 =CheckResult1.start ! ! ! !
D | f 2 [canected] 1 1 : 1
J H i =CljeckResult?. start_| ’->11J ! | !
i I & 4 T 13 | ]
| i i 3 synchronizea(CheciResui?) | | |
' 1 ] q PP 4. bynchronizedithis) | !
a L [ 78, 5 connand | | |
i E E 1 7 UpdatelTA0) : syncmont:ea(tr?s)
i | | J
| 1 )
] 1 1
| ] )
] 1 1
| 1 ]
1 1 1
| 1 i
] 1
1 ]
. HE:
1 1
1 |
] 1
| ]
I 1
| ]

Il
+—
|
|
|
)
)

T
1
i
ll
1
1

31 3.23 usasinou TaezinsuvesmsiidaIas Tusnismauilans esnugy

]
=S

4 4 1 (-1 o ° - o o
NN 323 dienisreuABIS VALY 9ZIINISISUINTANIIATIVADUNAGNS

& o 1 @ v 1 o [
(CheckResult) #35udoyasndaumsiudoyaninderuoun  (ReceiveCommand) %aa91n
v 9 o v < o o v d o
Tasudoyauaziimsasivasuwaanindanegiinisdivljanadng  (UpdateNXT) uagii
msuaaana  luvamideamudislimsaiugumsiinuvesusudmsamsdasidaniugy

=] a o £ o v 4 a’l

(SendCommandPC) Nezi3umsniau #lumsamshnuiuniesniuguianuaszdeaiing

o = A o 1
widalas ludive Itns 1dnswensluszuuiiuliledsgndes
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sd Robot Thead |

 btc | |man:Thread| | checkSend ||  command | [ command
: Conmnection : . Thread : RecetveCommand : SendCommand
1

|
1 [con;L:cted]

T
|
|
|
|
|
|
|
|
|
I
|

2: cdmmand()

r.g._-____-___

H 3: synchranized(this)
i
I 4: synchronized(this)

|

1

|

|

:
1 5 caimand()
8
1

|

|

1

1

1

1

i}
]
]
I
|
|
!
!
I
i
1
I
|
"

4 °o_a L4 ° y 1 o
1 3.24 uaasdnu laezunsuveansiiFelas lugmsianiiuoua

mngﬂﬁ 3.24 LﬁamiL‘T;amiam%'imuumfwzmmsﬁ'umsﬂmsﬁmaﬁwﬁ (CheckSend)
AUMIANTIMITUAEN (Main) 9291M1 330013 5uA1H (ReceiveCommand) Flumsams
v‘hqmi'hviuuuGW?W:Jﬂ%ze’faqﬁmiﬁﬁﬂns"luiﬁ'ialﬁms1%’n¥wu1ni"luizumﬂu'lﬂau'n
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[ wxr ][ o0:6:53:05:d1:6e |

115:30:26: [[Set Robot | OK]] »
15:30:28: [[Set interval OK]]

115:30:28: Signal update=255

115:30:28: Battery voltage update=6951
115:30:32: Signal update=205

115:30:32: Battery voltage update=63937
115:30:37: Signal update=207

115:30:37; Battery voltage update=6868

115:30:37; [[Move forward OK]
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15:30:37: [[Move forward OK]] ad
15:30:39: [[Move backward OK]]
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15:30:43: Battery voltage update=6965
15:30:48: Signal update=208

15:30:48: Battery voltage update=6854
156:30:52: [[Turn left OK]]
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15:30:54: Battery voltage update=6854
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15:31:37: Signal update=207 s
115:31:37: Battery voltage update=6882
115:31:41: Signal update=208

115:31:41: Battery voltage update=6923
115:31:46: Signal update=208

115:31:46: Battery voltage update=6896
15:31:51; [[Adjust left OK]]

|15:31:53; Signal update=208
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[ wxt ][ o0:es3:05:d1:8e |

15:30:55: [[Turn right OK]] o)
15:30:58: Signal update=208

15:30:58: Battery voltage update=6951
15:31:04: Signal update=208

15:31:04: Battery voltage update=6896
15:31:09: Signal update=208

15:31:09: Battery voltage update=6896
15:31:11: [[Stop moving OK]]

15:31:14: Signal update=207

15:31:14: Battery voltage update=6923
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[ wxt || oo:6s305:dige |

115:33:22: Battery voltage update=6840 |~
115:33:22: [[Set Robot | OK]]

115:33:24: [[Set interval OK])

1185:33:27: Signal update=207

115:33:27: Battery voltage update=6799
115:33:30: [[Set speed low OK]]

16:33:32; [[Set speed medium OK]]
115:33:34; Signal update=207

115:33:34: Battery voltage update=6840
i15:33:34: [[Set speed fast OK]]
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L naummﬂm LeJOS NXJ UH Windows XP
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| mindsTorms
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e Downioad NAJ oy
API Win32 le)OS NXJ
PC API
Tutorial Download Click to download from Sourceforge
Dawnload Mac OSX
" Wi/ 0SX laJOS NXJ
API Download Click to download from
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RCX Brick
leJOS RCX Other releases; notes, dates and sizes are available at the SourceForge download area,
API
FAQ
Forum
Books
Links
Contact
AFCEH RGE
java.net
A ey
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Welcome to the InstalDammer Wizard for leJOS
no

This will instali leJOS NXJ version 0.7 on your computer,

It is recommended that you close all other applications
before continuing.

Click Next to continue or Cancel to exit Setup.

H ¥
317 0.3 ueraan1sAnna 11sunsu LeJOS NXJ

q’: o < { o $ ° a u’/‘ 9
4. nmivvzidumsfmualal aneindn(Root direstory) Naziiimsaada 1sunsy uda

AANY Next AU .4

Where should leJOS NXJ be installed?

Setup will install leJOS NXJ in the following folder.

{ ghstaﬂ to this folder, dlick Next. To install to a different folder, dick Browse and select another
i folder,

10K versionis 1.6.0_07

Destination Folder
C:'\Program Files{eJOS NXJ
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3 ° < a ° a u’;‘ o 1 o
5. infmuvzsﬂumsmnuﬂ'lmsnnasmzmmmnm'[ﬂimﬂmamaﬁmsmﬂuummﬂu

MINAUITZUY A9 n.5

Where should leJOS NXJ projects be installed?

Setup will install leJOS NXJ projects in the following folder.

| Toinstall to this folder, dick Next. To install to a different folder, dick Browse and select another
| folder.

| The default folder is C:{Users\Lawrie je JOSNX JProjects

| Projects Folder -
‘ <%Home%> /e JOSNXIProjects

| Instaklanimer

&P, (R

17 05 namamsdmun ladamesnanizshnsAade Tusunsy

¥
g

q’: = n’: o =) a o n’: = ¥V £
6. MU T15uNINAAAIZIINITUAALS WASIBIANISAAAIBNATI NINTWDLIBIARNADI 1Y

AAN1Y Next 3317 .6
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Review settings before copying files

Setup has enough information to start copying the program files. If you want to review or
change any settings, dick Back. If you are satisfied with the settings, click Next to begin copying
| files,

Install Directory: __J
C:'\Program Files{eJOS NXJ I

{ Projects Directory:

C:'\Users\Lawrie e JOSNXJProjects

Setup Type:
Typical

|
|

H

—rJ i

|

|

1 E
31 0.6 nanaaZIBEANITAAAT

v ¥ '
TilsunsuAnAnziinmsAnAs LeJOS NXJ fagilil n.7

Installing leJ0S NXJ

Please wait while Setup installs ieJOS NXJ on your computer,

| Instaling Projects...

H v ¥
UM 0.7 uamaniheefidsAnns Aana LeJOS NXJ
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The InstallJammer Wizard has successfully installed leJOS
NXJ, Click Finish to exit the wizard.

When you dick Finish, the firmware flash program titled
“Install NXJ Firmware in NXT™ will run. Follow the
instructions on the screen and it will update the firmware
on your NXT to leJOS NXJ 0.7.

When you exit the firmware flash program, this setup
program will finish,

If the firmware flash program does not run, go to the bin
folder in your installation directory and run nxjflashg.bat.

o ¥ R AN & 7
JuUN 0.8 uaasvTeBMISARA TS VeIl
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) d J
wmumsﬁﬂmnﬂsmm LeJOS NXJ

U LEGO MINDSTORMS NXT

o s a .’J ' o o a’g a
1. mnsuinAAAIeYAY LEGO MINDSTORMS NXT Wuilsuinsauduveauald

3 o N ° a q‘l‘ 4 4 U o
wAsnhMITiranisRinuneuiIMsAARuliuLITYee LeJOS NXI  Tasnisnaijuiands

317 #1915 5 il Kagali w1

i ° ' ° a W o
UM .1 ugaimsSmmahauneuiinsAnsulli NI Yes LeJOS NXJ

o : o L { - % ¥ ° 9. 4 i .
2. wasmmiuiinmad g ladnanes Nejos nxjbin 1d WM sTulWaN¥o nxjflashg.bat

) v '
oila Tsunsudmuaadulsunrives LeJOS NXJ dagiln v.2

»

W

& mfm_mhh jmu
[@]7s j’”?"“‘—

o bat mhw-hd
M5-DOS Bateh Fie o

3k

s m..

s B EEE
Hmn Hmu -
31.|'n .2 naaslasanesves W 4o nxjflashg bat

* ] Publch th et the
3 Emalthis e
| b Print this file

[ 3¢ Delete this fie
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[ 9y '
3. 1N13AAN Start program LWBAAAUNTUINTYA LeJOS NXJ Aagalil v.3

§ a c’: o
510 v.3 uamanihwemsAadauils s ues LeJOS NXJ

: oy 3 o A 1 ' 3 dat o
4. il'lﬂu‘uﬂZII'UE]ﬂ'J'IllUfJﬂI'H'VI'Iﬂ'lﬁl‘l!f]ilﬂﬂ USB ‘izmmaumnmnﬂaﬂ‘niamamnz

& a 4 G’l a o {
1nF0INBNNUADT 9INHUATN OK AN ¥.4

. - ‘_ W i o 3 ¥ s '.‘A,” s A .' s 4 S O ‘ L SRR
91 v.4 urmandosdonnuusnliviimsioude USB szuhueudndiinew Insaiesiny

A a o
IATDINDUNIUADT

: A o o { { - =
5. nimiusziidennuieBudiu Aagii v.5 uazgili v.e WMihinsndn Yes uaz OK

ANRIAY
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51/ v.6 uansdonnufouldilauazi¥onse NXT

d o a O v ¢ w i
6. TisunsuaziFuiinisAnduiliuniives LeJOS NXJ Hazuaainszuiums asgli v.7

Progress Log

Building Firmware Image
VM file: binMlejos_nxt_rom.bin

Menu file: wini\StantUpTextbin
VM size: 43036 bytes.

Menu size: 32527 byles.

Totalimage size 80655/31820 bytes.

No devices mfirmware update mode were found.
Searching for ather N<T devices..

Building Firmware image
VM file: . \binliejos_md_rom.bin

Menu file: \bin\StartUpText bin
VM size: 48086 bytes.

Menu size: 32527 bytes,

Total image size 80655/81820 bytes.

Neodevices in firmware update mode were found.
Searching for other MXT devices. .

found NOISY Bluetooth address 001653007548
Waiting for devicetare-boot.. . . . .o
still waiting . . .

31 4.7 uamsmsAad Ul s U Y09 LeJOS NXJ
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A o a n’: 4 o S = =Y v 9 a 3

7. e imsAaRuNsuIITYDI LeJOS NXJ (a5 aisvuson vz livon1uniuindeinisanma
v

WS uasves LeJos NXJ Iniidnasiniely 1aou No nin'lidean1snienon Yes nin

S A [ {
Tnsamesaidu Azl v.8

a & a¢ ¢ 9 Yo d ¢
ﬁ,l’ﬂwiﬂ'liﬂﬂﬂilﬁilllniﬂlﬂﬁ LeJOS NXJ 'lnu'lﬁﬂmaumnmﬁﬂau

Yes || Mo

| SESENRSHE TR

H L4
71l 0.8 namimsARRUNuIDT V03 LeJOS NXT@Saisvuioy
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TundUMIUSUUA Netbeans INDIF3143IUHY LeJOS NXJ

1. M5AAAY Netbeans

.

1.1 a3 InaaTsunsu1dein http://www.netbeans.info/downloads/index.php ﬁd;ﬂ'ﬂ

a.1 19 click ﬁﬂu Download NetBeans IDE (H81390 mirror site 14N13 download

Home » Products Plugins

N7, NetBeans 5.5.1 Installer
{Windows/English (en))
netbeans-5_5_1-windows.exe (53.7 MB)
MD5: 693025292a58b7153087d1460bcd5f750

Download NetBeans IDE )

R - W e itk S

Other Systems & Lanquages

1 a.1 uaraantine lunisaind InaaTlsunsa netbeans

1.2 /o download tarFaud? v 18 1Wa netbeans-5 5 _1-windows.exe 41 MAUUAA A
Tisun3a NetBeans 5.5:1 1au double click N 1Wa netbeans-5_5 1-windows.exe Tisunsu

Installer HerAadonNUABUTY Aa310 0.2 click 1 Next e Thmihedely)

& INetBeans IDE 5.5.1 Installer
yme to-the. lnstall Wizard

| The Install Wizard will install NetBeans IDE 5.5.1 on your computer.
| To continue, choose Next.
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1.3 10001 accept the terms in the license agreement U click Next 1ie 11 11 A

i a3

g NetBeans IDE 5.5.1 Installer

| Please read the following license agreement carefully.

NetBeans Version 5.5.1

Please review the complete list of open-source licenses
governing software included in this software. They can be
| |found in the THIRDPARTYLICENSE. b file.

| | Please review the list of libraries and licenses provided
for use and redistribution by other parties. These libraries
are redistributable subjectto the conditions in the
DISTRIBUTION.ba file.

1 This license file contains five distinct licenses.

| | LICENSE #1: The Common Development and Distribution License
(CDDL). Version 1.0 aoverns vour use of: _"_J

| @ )acceptthe terms In the license agreemenf

" 1do not accept the terms in the license agreement

nsliShiehl ——— e

' A
3UN a3 uaaamivonaasiion lywes lilsunsy

l £ '
1.4 Tulsunsu Installer 9519151521 path N5 1ADINITAAAT NetBeans 1151521 path 1

' 9y » .
1570ams  Aaguli .4 I click N Next tito i iiwo Ty

£ INetBeans IDE 5.5.1 Installer

Click Nextto install NetBeans IDE 5.5.1 to this directary, or click browse to Install
| 1o a different diractory. You must choose a new or an emply directory where you
l have write permission
| Directory Name:

{C:\Program Filesinetbeans-5.5.1

Browse ]

9

] ¥
A19321) path NABINIsARRS Tlsunsw

31N a4 uarmanihee v
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1.5 Ta/sunsy Installer 92499M1 JDK 5 30 6 NUDY lUATOWAZLAAL path Y89 DK
fwy TugaTalsunsy Installler wis JDK version 1.5.0_06lunsdifiisas JDK 13nany version

3171501090 19 version NM51A0IN13 18 TaotAon Browse click N Next 1o 11ntiae 11

£ INetBeans IDE 5.5.1 Installer

Select a Java 2 Standard Edition JDK installed on your machine from the list
below. You can pick a different JOK by typing in its installation directory or using
| the Browse button. J28E JDK 1.5.0 or later is required.

J28E JDK Home Directory:
Ip:ydki1 5.0_06

Browse

List of suitable J28E JDKs found on this machine:

InstallShie il - e —

ARTTESETSE TT

714 a.5 1A path ¥4 JDK Hinnluniesneunaines

' v v | vy
1.6 TU31n73 Installer (53Aa63 11311053 NetBeans 031 path N1521) iilofans

g { . o &
TsunsuaiaGaniosnda click N Finish iWov Talsunsa ez 0.6

& INetBeans IDE 5.5.1 Installer

| The Install Wizard has successfully installed NetBeans IDE 5.5.1 on your
i computer. Choose Finish to exit the Wizard.

| NetBeans IDE 5.5.1 installation location:
ditempinetbeans-5.5.1

| To run the IDE, launch:
; d\tempinetbeans-5.5.1\bin\netbeans.exe

| To uninstall the IDE, launch:
dtempinetbeans-5.5.11_uninstwninstaller.exe

a ) 4 a o ¢
3UM .6 uamsmieedionisaans Tsunsuas seruys el



93

2. msaulisioamenannszuudajueua

h.

2.1 M1Ms1la 1eJOS NXJ samples project Tamﬁanﬁmg File >Open project ﬁ'ﬂgﬂﬂ

'
I3

BN ] v
.7 18113 Browse lUdsdwunvalasnneinaadsdiedialisiwn1ld TaeTusiendaedran

wannluflajuoudezegluTnames samples

® nyprojectPC - HetBeans IDF 6.1

File Edt View Navigate Source Refactor
| New Project... Ctrh+Shift+N
1 New File... CurlN

| Open Project... Ctri+-Shift+0
»

Close "myprojectPC"
Open Recent File »

Project Group 4
Set Main Project »
“myprojectPC” Properties
3 Cri+S
Save As...

&g sy e Shit+5

Page Setup.,..
Print to HTML. ..

Exit

JUN A.7 uaAen3itla 1eJOS NXJ samples project

22 dieimatlallseadrediaznuiilswadioge Asgin g

File Edt WView Favorkes Tools Help

ek - 5 T Dsewch | Foders [TH7]e ) Folder sync

C:\lejos_nxjlprojectsisamples
00 BlueStats o /NXTServoTest & .project

- PerformanceTest & build. xml

i /PFTest ¥ manifest.mf

i 'PilotTester & samples.prope

. 'RCNavigator

+'RCXEmulator

 JRCXMMTest

. 'RCXMuxTest

{JRCXPortTest

+.’RCXRemote

J Make a new folder
&) Publish this folder to the
Web

4s/ Share this folder

¥
@ o 1

717 .8 uanIn1s Browse lildsdumislasnneiidadsiediaision

4 ¥
2.3 nimiuinmsa$aTusienlviTaens 114 file > New Project >Java>Java

Applicaton LAINANTJY Next As31l7 7.9



" Project_name - HetBeans IDE 6.1

File Edt View Navigate Source Refactor

¥ | New Project... Ctr-Shift+N

7| New File... Chri+N

(e Open Project... Ctri+Shift+0 |

N

Close "Project_name"
Open File...
Open Recent File »
Project Group b 3
Set Main Project b -

"Project_name" Properties

- atrl+3
3UN a9 uaaamsadalusnlny

n‘: ° G‘I’ 4 { i\ 2 Y/ o d {
2.4 nintiulsimsds¥e I sien Tuinii19%091 “Project_name” fviualaiinnein

wuTilsin uazdmuadaidendeqasgil udnanify Finish #3117 .10

Steps Name and Location

1. ChooseProject Project Name:  Project_name
Profect Locatior: - CYefos_ocgrojects Xz’ ¢

[ (o, ]
ProfectFoder: - € ejos, ofprofectsiProect_pame |

[} Use Dedicated Folder for Storing Libraries
ubraries Folder oz iage (2% &

Diffsrant Lsers and prapstts can shefethe same compilstion #braries (ses Help For details).

[ Create Main Class ipraject_name Man
[¥] Set as Main Project

[<oeck ] [ Fnish ] [ Concel | [ el ]

v Y
3UM a.10 uaaanisnisas¥e T1lsien

94
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n’: a4 g W =
2.5 iniuvzalsng Tusianad1a 13 luunmy Project agiii .11

%imi-' . xi ﬁ"’, . Services |

& & myprojectPC “

&5 myprojectPC_all I

58 pcsamples | = g
#-13 Source Packages

. @#-i3 Test Packages

z tj Libraries

@@ Test Libraries

&% robotproject

& samples wy

'
[

4
gﬂn n.11 Lmﬂﬂﬂmﬂmnaﬂwu

E 4 v ¥
2.6 nimiuiimsaany i Tuswanasd1a 13 i@en Properties > Libraries > Add

/. ) U
jar/folder UAIMINISINW classes jar ¥30¢ 11 . \lejos. nxjlib Aag1lii £.12

Project Properties - Project_name

o Sources | JavaPlatformi DK16(efodk) v
o Libraries ; O BB G ONEATNSASE &A1Y SRS
> Compiling

| Complle | Run ! Compll Tests| RunTests|

= A S22 n B NN\ | Ss | £ ) 4 ?TQB 3 {
. ggfmm&t-llb.’n.juh Z .]pctooh)e\o Use Relative Path: o
=) fnput.far ] servlet.j¢ e g
| ] ext-2.1.3.ar ] Joystick.jar =] substanc ol SIS 4
] jcommon-1.0.14.jar {] tools. jar [2) sweorapk; () Lse bsokze path;
)] Freechart-1.0.11-experimental.jar | =] funit.jar " [C:Vlejos_mjbiclasses. jor
| =] ffreechart-1.0,11-swt.jar | 2] pecomm.jar |
72 e i g

File name: classes. jar

[_oeen_]
Fles of type: | Classpath Entry (flder, ZIP or JAR fl) _ e o ]

Comple—tinel:ruiesae ated to all ibrary catego

-whujar.tsmcluspath

Lok J[ concel |[ reb |

3UM a.12 uaasmaiunaraasluTisen
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2.7 "msade Java Package Tauadnvn IWames Source Packages >New> Java

® 1A {ciq Y& 1 ) o §
Package 10211113 1d %004 Java Package uiiii 1940891 “org. me.myproject” Aag1lii .13

@ rroject name - HetBeans DF 6.1
Fle Edt View Navigste Source Refactor Buld Run Profile Versioning Tooks Window Help
PSS X0 E ¢ waew WYY DE
‘!i'i- l‘$ Files Services | u@&a'tiﬂcéiinluwa ;f&ﬂ Ciqua}hdﬁ@ﬁwu >
vl Jicnint | source | Dosn 1 00 - &)
# & myprojectPC_al J—lw' : Bl Ll
+ Bt pesamples [ o1em
= & Project_name 1672

- _ﬁwsrucnplduws | 1673

=] <defauk package’ - z T

# () TestPackages - : £ = ’q:""';

+ [ Lbraries Crk+F | Frame e

+ (g TestLbraries iy | (D Folder...
+ (% robotproject Copy CrC ) Java Package..,
=, > criey | Java Interface..
W-m& . L_j -
{ Members View Delete ‘J.'
=-{y PCeontrol :; JFrama. EHEN’YCh“"'hw“

PCcontrol() \ 1] Entity Classes Database. ..
- Reverse Engineer... 7

7'{ Other...

&5 ButtoniOActionPerfo L ocal History »
& Buttont LactionPerfo
&), Buttont2ActionPerfa. . 109 X

ool b i1 deBb |
;. puttont4ActionPerformed(iictiont |/ Lo |
i & PButton1SactionPerformed(:-t x ,i: \690
< | Lo AL degl

7% A.13 uanensad e mwAng

v 1
2.8 1A URINITA3N Java main class launi3aanyi Package org.me.myproject

>New>Java class uaxmmﬂﬂ'%um Java class luﬁﬁ'l#%mh “HelloWorld” ﬁﬂiﬂﬁ f.14

Proj. @ x Fles | Services 1:.7. B pecontroljava x | ] Camera_Controljava x|
# & myprojectPC ~11'source | Design B [ - 1~ 71l
# (& myprojectPC_al y ‘}L'rg-m"r"—" PR QST
# % pesamples 1671 i

= .‘& Project_name 1672

Ctri+¥ | Java Interface...

Delete Delete | Lt Panel Form.
Refactor N 1] Entity Class,..
18] Entity Classes from Database
Reverse Engineer... -
| Other...
Compile Package F9
Local History »
<No View Available
Tools »
| 1bby
! 1689
| 1690 |
11691 1

JUN a4 uamamsadrenanalulisen
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2.9 nimiwmhmsud luIAan el IWa Helloworld 1¥iiludsgilii 15 ilenaaouns
Mamveslilsunsy

package org.me.myproject;

import lejos.nxt.*;
public class HelloWorld {

public static void main(String[] args) {

System.out.println("Hello World");
Button.waitForPress|();

}
31 a.15 ugasnisud Ty IRan1w1uTHe HelloWorld

n‘: o A g ) 4
2.10 MIMTUTINIG copy WA buildxml 1indredreTdsenn 1aidla 13 1ude 1.1 uaz

1.2 113 Tvlaines Source Packages A3z1/ii .16

Fle Edt View Navigate Sowrce Refactor

O « 0

@15 Test Package
% (@ Libraries

| @@ Test Libraries

#-( robotproject
=-&# samples

=) BlueStats

=[] <default da

+.ﬁ BTConnectTest

#-1) BTGPS

BTReceive )
b

. TR P —

517 7.16 1aAIM3 copy IWAT® build xml 11ndretraTus19ni 181013 Tuld Iaimey

Source Packages
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v
=)

> 2 é "
2.11 1nuEla TWa build.xm! Yuxudavinsud luasil

e avudenanu <basename property="program" file="."/> l.”i‘_lu<property

-

name="program" value="HelloWorld">
® Imsnu property:

<property name="class" value="org.me.myproject. HelloWorld">

v [ v
® 9nuuluaiu link target, nlasuvssnaniidonnu

<arg value="$ {program}"/> i <arg value="${class}"/>

A Lad—
2.12 qaNn 1811013 copy IWaNnT¥e37 sample.properties 910 I ata0s

A B a4 4
... \lejos_nxj\projects\samples 11/ 1383 TWames Isiaandrdaiant lunife Inameise

Project_name ﬁﬂjﬂﬁ f.17

310 A.17 uanIn3 copy IWaNTIFeI1 sample.properties 9110 IaAD3 .. \ljos_nxj\

v W

projects\samples 11138 Ilaines 1 siwafididaiang

4 o [ o' ° & ' ' 1 &
2.13 iisdeanisdnInan IWd lfajuoudliimsi¥oudesenauouduazinios
a o -~ : Y o ' o o a d’
AoNNAABIAIaI  USB nio ugys vinvuldiinsidlayuoud udminisadnuai
. o o o cg { g '
build.xmI>Run Target>uploadandrun 91NUUNIN upload U7 v9ziivennuAUNUNY Output 31

“BUILD SUCCESSFUL” A331/% 7.18



"§ 5& pcsamples ' !
= @ Project_name <1 8
=13 Source Packages i 2 ' A
=[] org.me.myproject i 10 Aauthor Inpi
[1®Helloworld.java | 1
£ buid,ve i 12 public class He.
1 ) Test Package .
+ @ Libraries ‘Run Target »  uploadandrun
%@ Testlibraries Debug Target »  dean
#- &5 robotproject Local History Y comple
(B-Gp samples | ¢ x| R
‘build.xml - Navigator  Copy Chrl+C upload
! 3“ T Delete Delete  Advanced...
L compile Rename...
2, link ‘
L& I SaveAsTemplate... s
mtput Javaapplw Tools »
B inic: "/ Properties _

. deps-clean:
" clean:
BUILD SUCCESSFUL (total time: 0 seconds)|

317 a.18 urasdvams oW Tvaa T T dajuoud

3. msaaldswameiannszuudauniesnunuPCc)
3.1 amaadaTusienlnaiTaons 1af file > New Project >Java>Java Applicaton

ud2ndaniju Next #3317 n.19

’ Project name - HetBeans IDE 6.1
He Eclt Vlew Navioabe Som:e Refu:tor

¥ New File... Ctren
(== Open Pro;ect... Ctri-Shift+0 [
- @aw, = ’ 1
Close "Project_name"
Open File...
Open Recent File »
Project Group (3
Set Main Project > - i
2

“Project_name" Properties

Ctri+S

1/ a19 uamansadiaTusionln
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n’: o ) A {a ' ° <
3.2 viniulvidimslda¥e Tusen Tunii19¥e1 “Project PC_name” fvualaiinne

id g ° o 3 [ a . = [ {
Sy Tusien uazdmuadudionaanasgal udandnily Finish Aagali 7.20

® uew Javs Application

Steps Name and Location

1. Choose Project Project Name:  Project_PC_name|

2. Name and Location 2 3 S i 5
Project Location:  C:\lejos_nfiprofects ) Browse... |
Project Fokder: :Jejos_mlprojectsiProject_PC_name

[[] Use Dedicated Folder for Storing Libraries
Ubraries Folder: | :

Different users and projects can share the same compilation libraries {see Help For details)

v P [ concel | [ oo ]

[] ¥y . ¥
714 n.20 namamsaaFe Tilsiwauaz lasanes iy Tusin

33 ntuiiimsaanyniTilseniadield don Properties > Libraries > Add
jar/folder u&avhin st s 3 aat
®  pocomm jar A petools.jar H30¢ 11 . \iejos_nxi\lib
® bluecove.jar ‘%\1 f){ﬁﬂ..\lejos__nijrdparty\lib
dovnaiiylausiranuaiiuds moluTils Tseftededinfuansoadas

java class 1émuilnd
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v
o

a :l w Y ﬂ' Y :
wmunﬁmmnmzﬂsmnmma'lmm%aﬁmﬂ

lun1sAndeiusesadn 1A 1fy The Lightweight Java Game Library (LWJGL) 1a¢ Joy
L3 d‘ o J o 1 Al
stick for java Tumsm IR szuURRANAUE NI OAIUAUAITINNIUVBIYUUARY
z & o g ! A @ = W o { A
vwuadn 14 Fananesldiusesanniu PU301 FawdnTavuTiin DILONG Aygilh ¥4

aW150A11 1aa driver 147 http://www.zidoupload.com/f-ai95hClr

' K ' < o 3 . ';;“-_ Y
Ui 9.1 uermsvasadngy PU30T ¥awdn lauu3En DILONG

1. YUABUNIIAAAI The Lightweight Java Game Library
1.1 n3AIi Inaa The Lightweight Java Game Library 970

http://sourceforge.net/project/showfiles.php?group id=58488&package id=54362&release_id=6
42951 Tav TWlafi¥o iwjgl2.0.1.zip Aagii 9.2
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Lightweight Java Game Library

& You have selected the LWIGL 2.0.1 release.
Please choose the file that best matches your architecture or operating system from the list of files contained in this

release.
% Options
; Package Release Filename | Size ‘ Architecture
Official Releases
Latest LWIGL2.0.1 [  (2008-11-25 21:47)

Iwigl-2.0.12i0 = 2424888 Platform-Independent
Iwigl applet-2.0.1.zip ™ 3225960 Platform-Independent
lwigl-docs-2.0.1.2i8 = 1508963 Platform-Independent
Iwigl-squrce-2:0.1.2ip = 1437397 Platform-Independent

Totals: 1 4 8597208

310 9.2 uermaIn3a121] IMaA The Lightweight Java Game Library

12 ifenmiTraad S IdimsuanIng zip denan

1.3 Netbeans Tﬂmnﬁﬁmnnﬁ’mus"mﬁusauaéné’mﬁ1n1sn"3u'laui1‘s‘nnﬁ"zﬁ
ot 1y ...lwjgl-2.0.1\Iwjgl-2.0.1\jar

14 vinlWdRogh . \wjgl2.0.1\wjgl-2.0. \aativetwin32 11d 131y C:Program
Files\Java\jdk1.6.0_10\bin

15 Mmssaminaouiaimes
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2.9UNDUMIAAAY Joy stick for java
2.1 MMy Ivaa Joy stick for java 910 http://sourceforge.net/project/

v o o
showfiles.php?group_id=55526 TaeIasiyen joyjava-src > joystick.zip ﬂﬂgﬂ'ﬂ .3

& Joystick for Java

This package is a development package for Java to use joysticks avaiable for Windows 9x / NT platforms on Java platforms.

Package Release Date . : Notes / Monitor Downloads
ioviava-sample JavadD May 13, 1999 £ 3 Download
=050 5-00 10 May 13, 1999 B3 Download

51 9.3 tamenisa1ii Inaa Joy stick for java

22 idienri Inaadudsliinisuan g zip dana1a

23 Netbeans Tilsanfidoamsiausaudinesaandewimaiilavsiso
Joystick.jar "r';mj'l'u ...\ joystick-0-7\joystick

24 h'IWdieglu joystick-0-7joystickuib /114N C:\Program
Files\Java\jdk1.6.0_10\jre\bin

25 MM AN NAONRUADS
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usneaegin 9.2 1A iamy Help > Joystick

S"'ﬁ’. dAo:nn Adjust left Sp:od up Adjust right
M = | B |~ i
|
Forward Rotate up :)
3
T Sot TR HgRt Rotate left < | Rotate right \,74
- 4
42 oS at
i s D
ra 4 ¥
S &
Rotate down » ~d
4
D G 7 ] eS| ““Speed = 3 level {slow,medium fast)
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ref.point
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NXTIInfo | nx1 || o0i6:53:05:d1:8e |
Status

Connected

207 03:58:53: Battery voltage update=7796 |4 { . Connect )

[03:58:53: Signal update=206 ——

© e 0358:5: Battery voltage Update=7754  {_ Disconpect )
¢ t:g.,l' 103:58:54: Signal update=206

"y 103:58:54: Battery voltage update=7782

= '03:58:55: Signal update=208 ;

103:58:55: Battery voltage update=7782 o

. 103:58:56: Signal update=207 |
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